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Introduc�on 
This method of crea�ng deduplicated counts from the Built for Zero Repor�ng Suite available in Business Objects 
through Wellsky works with Microso� Excel in most versions since 2013. It does not work in the Desktop Office Standard 
2013 and 2016 version, though. To check the version of Desktop Excel you use, Click File, then click Account and you will 
see something like this in the top right of your display. More informa�on on data modeling capabili�es are available 
through Microso� and there are many videos available on Youtube.  

Installing add-ins necessary to Use Power Pivot 
You may need to install a couple of Add-ins to Excel to work with Power Pivot to automa�cally get deduplicated counts. 
Here are resources from Microso� to help figure out which you will need. Use Power Pivot in Excel  

For this instruc�on set, we will use the Built for Zero Case Conferencing Report v04.11, Built for Zero Inflow Report 
v04.11, and Built for Zero Ou�low Report v04.11 for the fic��ous community of Danville to report on all BfZ repor�ng 
metrics for Single Adults for April 2023, using the prompts in Figure 2and running the reports on the same day.  

Report Prompt Value Selected 
Repor�ng Group CS report(43);FY 22 PSH DQ(67);FY 22 RRH 

DQ(66) 
Show Names No 
Client Loca�on All Loca�ons 
Enter effec�ve date 05/01/2023 
Beginning of Lookback Period 05/01/2021 
Two Months Before Effec�ve Date 03/01/2023 
Four Months Before Effec�ve Date 01/01/2023 
Date and Time Report Run 05/17/2023 9:45 AM 
User Running Report danville_live:elockley 
Refresh Status Fully Refreshed 

Figure 2 - Prompts for all reports run on the same day. 

Figure 1 - Product information from Excel 

https://support.microsoft.com/en-us/office/create-a-data-model-in-excel-87e7a54c-87dc-488e-9410-5c75dbcb0f7b
https://support.microsoft.com/en-us/office/start-the-power-pivot-add-in-for-excel-a891a66d-36e3-43fc-81e8-fc4798f39ea8


Use Power Pivot to Report BFZ Metrics from Excel 

Page 3 of 13 
 

Preparing any Business Objects Table for Use in Excel 
Business Objects file exports in Excel file format introduce some nonprin�ng characters that interfere with Excel’s full 
func�onality and will affect usability of this data for BFZ repor�ng. Strip these characters out and maintain full 
func�onality in Excel by clearing the formats on the data set you’re working with when you start to work with it. The 
reports in the BFZ repor�ng suite are op�mized to facilitate working with them outside of Business Objects. This is put to 
best effect in the for viz versions of the tables because the simple aggregates and the �tles are removed from the for Viz 
data sets. The instruc�ons in this sec�on are based on the Ac�ve Client Details for Viz tab in the Case Conferencing 
report which has the most complete set of informa�on about each person on the Ac�ve List. The skills learned, here will 
transfer perfectly to Inflow and Ou�low data sets, also. Repea�ng the skills on the New Client Details for Viz, Housed 
Returns Details for Viz, and Inac�ve Return Details for Viz from the Inflow report and Housed Clients Exi�ng, LOT to 
Housing for Viz, and Newly Inac�ve for Viz will complete all repor�ng metrics for Built for Zero with the excep�on of no 
longer meets popula�on defini�on.  

1. Select the en�re range of the data table by clicking anywhere in the data range and pressing Ctrl+A. Find the 
Edi�ng group (Figure 3) on the right side of the Home Tab of the ribbon.  

2. Click the Down arrow on the Clear buton and then select Formats. The change will be most obvious in Case 
Conferencing, because the color codes will all disappear, but all date formats will also revert to serialized date 
format (just a number) The table will looking like Figure 4 before the clearing of the formats: 

LOT 
Approx to 

Exit/Current 
Has CE 

Enrollment 

Enrollment 
Outside 

CE 
SO/TH/ES/SH 
Enrollment 

PH 
Enrollment Provider 

454 Yes No No No Danville Coordinated Assessment(103) 

431 Yes No No No Danville Coordinated Assessment(103) 

1708 Yes No No No Danville Coordinated Assessment(103) 
Figure 4 - Table section from Case Conferencing Active Client Details for Viz 

A�er you clear the formats, it will be very plain, like Figure 5. 

LOT Approx to 
Exit/Current 

Has CE 
Enrollment 

Enrollment 
Outside CE 

SO/TH/ES/SH 
Enrollment 

PH 
Enrollmen
t Provider 

454 Yes No No No 
Danville Coordinated 
Assessment(103) 

431 Yes No No No 
Danville Coordinated 
Assessment(103) 

1708 Yes No No No 
Danville Coordinated 
Assessment(103) 

Figure 5 - Same table with formats cleared. 

Figure 3 – Editing Group, Home Tab 
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Crea�ng an Excel Table 

3. Select any one cell (AP2 selected in Figure 6 for demonstra�on) with data in the table and then click Format as 
Table in the Styles group of the Home Tab (Figure 7) and choose any table style you like from the gallery. Using 
Excel Tables super charges your ability to work with data. 

4. Verify that Excel selected the correct range for the table in the Create Table dialogue box (Figure 8) and make 
sure that you select My table has headers.  

5. The Table will reformat like Figure 9. No�ce that there are filters on each column among many other features.  

6. Select each of the date columns in the table by CTRL + clicking on the column header to select the en�re column. 
Reformat them as dates. It should look like Figure 10. No�ce that AP2 that we looked at in step 3 is s�ll the 
selected cell.  

Figure 8 - Create Table Dialogue Box 

Figure 9 - Table format White, Table Style Light 8 applied to unformatted date columns 

Figure 10 - Date Columns reformatted as short date formats 

Figure 6 - Unformatted data and Styles group of Home Tab 

Figure 7 - Format as Table Gallery 
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Scroll down a bit and no�ce that the column header names from the report replace the Column leters in the 
headers once the selected cell is below what would allow the headers row to display on your display (Figure 11). 
Cells in an Excel Table s�ll largely func�on as you would expect an Excel cell to behave, but there are a lot more 
features and it is much easier to keep up with Last Entry Date than column AP. The selected cell below is cell AP7 
a�er we scrolled down far enough that the headers rolled off the display.  

Naming Tables, Adding them to Data Models and Crea�ng a PivotTable 
7. When working with many tables, it is helpful to name the tables something meaningful. Make sure a cell in the 

table is selected and click the Table Design tab on the ribbon. Find Table Name in the Proper�es Group (Figure 
12). It will be on the far le�. Select Table1 (or a different number if you have made other tables) and change it to 
Ac�ve. The naming rules permit no spaces and it must begin with a leter.  

8. Click Summarize with PivotTable in the Tools group. 
9. Select Add this data to the Data Model in the PivotTable from table or range dialogue box and make sure the 

correct table name is in the Table/Range field. (Figure 13)Click OK. 

Adding the data to the data model is cri�cal to finding deduplicated counts in Excel, using data models also 
creates a lot more func�onality beyond the needs in repor�ng BFZ data. If you do not have the op�on to Add this 
data to the Data Model, return to the Installing add-ins necessary to Use Power Pivot sec�on and make sure you 
have the right add-ins enabled for your version of Excel and a version of Excel which supports Power Pivot.  

Figure 11 - Table Headers automatically replace column reference letters 

Figure 12 - Properties and Tools Groups of the Table Design Tab 

Figure 13 - Pivot Table from table or range  dialogue box 
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10. A new worksheet named Sheet1 with a pivot table will be created to the le� of the worksheet with your data 
table (Figure 14). 

Crea�ng Measures to Count Households and Individuals 
11. Go to the Power Pivot tab on the ribbon. Click the Measures Arrow in the Calcula�ons Group and select New 

Measure (Figure 15).  

12. Complete the Measure dialogue box as in Figure 16. The func�on to get a deduplicated count is Dis�nctCount(). 
Start typing in the formula window =dis�nctcount. Excel will supply sugges�ons based on what you type. Select 
or type it out. Once the func�on is selected, Excel will suggest Columns to use in the count. You want Client 
Unique ID to get a correct deduplicated count of clients. Client Uid is searchable, but could poten�ally have 
mul�ple ID numbers for the same person.  

Figure 14 - New Pivot Table Created on Sheet1 

Figure 15 - Measures Button on the Calculations Group of the Power Pivot Tab 

Figure 16 - Measure Dialogue Box 
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The correct formula is: 
 
=DISTINCTCOUNT(Active[Client Unique Id]) 
 

to count individuals on any list. Distinctcount() counts each unique value in a list. So no mater the number of 
occurrences in the list, it will count the same value only one �me. In the formula, note that Ac�ve refers to the 
table name and [Client Unique Id] in square brackets is the name of the column. Make sure the Table name is the 
one you intend to evaluate. It can get a litle confusing when you have mul�ple tables, which is why it’s helpful to 
name the tables as you create them. Type Ac�ve Clients in the Measure name field and op�onally fill in the 
Descrip�on box. Click OK.  

13. The count automa�cally displays in the pivot table with a column Header of Ac�ve Clients – the name you gave 
the measure.  

14. Repeat the process of crea�ng a measure in Step 12 to make a measure called Ac�ve Households to count the 
number of households using the Household Iden�fier Column. Use Household Iden�fier, not Household Id.  
 
The Household Id number is only available for clients who are part of a household. It is the number of the 
household in the Household management screen in Community Services. Household Iden�fier uses the 
Household Id number for households enrolled as part of a group but replaces the Client Unique Id for people 
with single enrollments, so people who may have been part of a household at one point, but are enrolled as a 
single, currently are counted correctly whether a household of one or part of household of several people. The 
formula will be:  
 
=DISTINCTCOUNT(Active[Household Identifier]) 
 

You can check and modify the measures you have created at any point by clicking manage measures. Your 
PivotTable should look like Figure 17, now.  

Figure 17 - Pivot Table with Active Clients and Active Household Distinct (Deduplicated) Counts 
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15. Click the Field List Buton in the Show group in the PivotTable Analyze tab If 
the PivotTable Fields Pane does not display similarly to Figure 18 on your 
display. The PivotTable Fields Pane layout may vary based on how you have 
Excel set up. Each column in the Ac�ve table displays as a possible op�on to 
subdivide your datasets for analysis. 

16. Click in the search bar and start typing Chronic. That will limit the fields 
available to those with Chronic in the name. Drag the Chronic Field to 
Columns and place above ∑ Values. 

17. Delete Chronic from the search bar and type Vet. Drag the Veteran Field to 
Rows and then drag ∑ Values above Veteran in rows, so the Drag fields 
between areas sec�on of the PivotTable Fields pane and the PivotTable 

should look like Figure 19.  

Customizing the Display by Adding Custom Columns in the Data Table 
18. To combine all non-veteran responses into “Non-Veteran” and make Yes (HUD) responses “Veteran” go to the 

Ac�ve table on the Ac�ve Client Details for Viz tab and select a cell in the Veteran column. Right click and select 
Insert and then Table Columns to the le�. The new column automa�cally gets a header of Column1. Go to the 
new column header cell and change it to Vet Simple. Select the row 2 cell in the Vet Simple column (BB2). 

19. The Func�on Wizard helps compartmentalize complex func�on elements and supplies correct syntax. Using it is 
op�onal, but makes wri�ng complex formulas much easier to get the syntax correct and to learn new func�ons. 
Click the Func�on Wizard buton to the le� of the formula bar. Type if in the Search for a func�on box, select IF 
and click OK.  

Figure 18 - PivotTable Fields Pane 
Figure 19 - PivotTable with Chronic on Columns and Veterans  on Rows and the Fields Area to set this up. 

Func�on Wizard 

Figure 20 - Function Wizard Button and Insert Function dialogue box 
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20. Make sure that Logical_test is selected in the Func�on Arguments Wizard dialogue box and click in the Veteran 
column in the same row as your ac�ve cell in Vet Simple (BC2). The Logical_test box will populate with 
[@Veteran] which references the en�re Veteran column rather than BC2. Type =”Yes (HUD)” with the quota�on 
marks. This completes the beginning of the sentence If the selected cell equals “Yes (HUD) then make this cell 
“Veteran” if not, then make it “Non-Veteran”. Type Veteran in the value_if_true field. Go to the Value_if_false 
field and no�ce that Excel adds the quota�on marks around Veteran in the Value_if_true field. Type Non-veteran 
and click OK. Compare to Figure 21 The final formula in the column should be:  
 

=IF([@Veteran]="Yes (HUD)","Veteran","Non-veteran") 
 
The func�on wizard (Figure 21) displays each part of the formula as it goes together. No�ce FALSE to the right of 
the Logical test, Then values to the rights of Value_if_true and Value_if_false and finally below those, =”Non-
veteran” Displaying every part of the process of the If func�on. 
 
If your formula uses RowColumn (BB3) references instead of column name [@Veteran] references, you probably 
shi�ed to a different row when you selected the cell in the veteran column. Tables automate crea�ng the same 
formula in every row of the column and use, elimina�ng formula copy errors. The Vet Simple Column should 
populate completely through the en�re table (Figure 22). 

Figure 21 - Function Arguments Dialogue box for IF function 

Figure 22 - Result of If function to group all Veteran responses into "Non Veteran" and "Veteran" 
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Refresh Pivot Table 
21. If you add or change data to a Table and Data Model, as we did in the Vet Simple Column, you must refresh any 

pivot tables relying on the data, to use the new data in the PivotTable. Return to the PivotTable tab. Select a cell 
within the pivot table. Right Click and select Refresh (Figure 23). If you make changes to the data table, the 
PivotTable must be refreshed to include them.  

22. Drag Veteran off the Rows and Find Vet Simple in the list of Available fields and drag it to rows.  The pivot table 
and field areas should look like Figure 24. 

Forma�ng a PivotTable 
23. Click the Down arrow at the botom right of the PivotTables Design Gallery on the Design Tab to expand it. Select 

a format that separates the data well (Figure 25). 
 

Figure 23 - Refresh Pivot Table 

Figure 24 - Pivot Table and Field Area with Vet Simple instead of Veteran 

Figure 25 - PivotTable Style Gallery and PivotTable 
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Adding Household Type as an Addi�onal Row 
24. One method to sort individuals into their Built for Zero household types keeps all data visible and adds another 

layer of categories to rows. The trick with working with pivot tables is keeping them simple and using only a few 
categories to subdivide your calcula�ons. 
 
Type BFZ in the Choose Fields to add to the report box on the PivotTable Fields Pane and drag BFZ Household 
Type to the top posi�on of Rows. The Pivot Table and fields area will look like Figure 26.  

25. Working with PivotTables is about 10% art and 90% pure data science. Some�mes it will make more sense to 
move data elements around so everything makes sense and is easily interpreted. Move ∑ Values to Columns 
below Chronic and click Subtotals in the Layout group of the Design Tab. Select Show all Subtotals at top of 
group. The PivotTable and fields area will look like Figure 27.  

Figure 26 - PivotTable and Field Area with Household Type added to Rows 

Figure 27 - PivotTable With Subtotals at Top and ∑Values on Columns 
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26. Drag the Ac�ve Households measure off of Values in the Fields Area. You can make a copy of the worksheet with 
the PivotTable and report on both Individuals and households if your community would like the data, but 
repor�ng only one measure on a complex table makes it simpler to understand. 
 
Click in cell A4 and replace Row Labels with by Household Type, Chronic, and Veteran Status. Resize the column 
and Wrap text in A4 so the text is visible. Select B3 and change the font color of Column Labels to the same as 
the background. You need to have something in the Column Labels and Row labels Cells, but in this case, Column 
Labels isn’t necessary and would make more sense to fade into the background. The easiest way to do that is to 
change the font color - Figure 28. 

27. To sort household types by order of magnitude, Click the Down Arrow in A4 and select More Sort Op�ons. Click 
the down arrow below Descending (Z to A) by: and select Ac�ve Clients - Figure 29. 

Researching Individuals from PivotTables 
28. In most communi�es, Unaccompanied Minors and No HoH or DOB Missing is a data quality error. Double Click 

on any number value in a pivot table to create a new worksheet tab of the rows from the data table that makeup 

Figure 28 - Final Table with Household Count removed. 

Figure 29 - Sort PivotTable by most common household type to least 

Figure 30 - Underlying data for Unaccompanied Minor household types 
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that calcula�on. Double click the number 1 iden�fying an unaccompanied minor, and Sheet 2 will be created. Go 
to Sheet 2 and rename it Unaccompanied Minors. In the sample dataset pictured in Figure 30, Client 31365 is 2 
years old and has mul�ple data quality issues and should be researched and corrected in the HMIS, backda�ng 
changes so they match the rest of their family.  

29. Return to the PivotTable on Sheet 1 and rename the worksheet Ac�ve Clients Summary. You can double click any 
number values you immediately suspect of being data entry errors to get a list filtered to just that subset to send 
a simple list to the appropriate people to do data cleanup.  

Changing Measures in the PivotTable 
30. Scroll to the very botom of the Available fields in the PivotTable Fields List. There will be a check mark in ∫x 

Ac�ve Clients, but no Checkmark in ∫x Ac�ve Households. Drag ∫x Ac�ve Households to the ∑ Values area and 
take the check mark out of ∫x Ac�ve from the field list. The pivot table is now calculated on the number of 
Households instead of the number of People. You can switch the measures back and forth as you like. 

Adding Fields to use as Filters 
31. You can add filters to a PivotTable to hide some data as an alterna�ve to adding it to a row or column. In many 

cases, this is repe��ve work when repor�ng on all data, but a useful case might be to find out more about 
popula�ons in specific projects. Make a Copy of the Ac�ve Client Summary Tab and name it Ac�ve Client 
Summary Filter. Find Provider in the fields list and drag it to the Filter area. Click the Down arrow in B1 and select 
a provider/ Danville Coordinated Assessment (103). From the sample set, Figure 31 shows there are 878 people 
on the BNL enrolled in the Coordinated Entry while the original PivotTable shows there are 999 people ac�ve on 
the BNL, which could be a data entry problem or clients entering from a side door into housing programs or 
shelters. 

 

 

Figure 31 - Copy of PivotTable sheet With Provider added as filter and filtered to coordinated entry project. 
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